
Email Organization 
 

 
Notes: 
Welcome to the training module titled, Email Organization. This training is offered by the State 
of Michigan, Records Management Services. 



 
Notes: 
Records Management Services offers training that defines: employee recordkeeping 
responsibilities, what a record is, how long to keep records, and how Retention and Disposal 
Schedules help agencies manage their records.   
 
This Email Organization training will not discuss those topics in depth. Please take the Basic 
Records Management class to learn more; it is a prerequisite for this class.  In addition, 
employees should take the Email Management training prior to taking this training.  
 
Also, this class assumes that users have general knowledge of email software and desktop 
computing.  If you need assistance with these topics, training is available online from the 
Microsoft Office 365 Training Center (http://support.office.com/en-us). 
 

https://stateofmichiganlearningcenter.csod.com/ui/lms-learning-details/app/course/e98c93f4-474a-42cb-bf04-21886ffe1c05
https://stateofmichiganlearningcenter.csod.com/ui/lms-learning-details/app/course/e98c93f4-474a-42cb-bf04-21886ffe1c05
https://stateofmichiganlearningcenter.csod.com/ui/lms-learning-details/app/course/5d642cb8-96dd-4f34-9823-c2c8361fcd29
http://support.office.com/en-us


 
Notes: 
Why should you clean up your email? 
Records that are kept too long waste space and money, and make it harder to find the stuff you 
need. 
 
Email should be stored with other records that document the activity or project.  Email 
accounts should be cleaned at least annually. 
 
 



 
Notes: 
It’s clean-up time! 
Do you have too much stuff in your email account?  Do you want to clean up your email 
account?  Is your boss telling you that you have to clean up your email account?   
 
This training contains tips for cleaning up your email account and maintaining a clean account 
into the future.  The goal is to help you keep what is relevant to you, and get rid of the rest.  
Hopefully, some of these tips will be useful to you. 
 



 
Notes: 
Tip:  Adopt a clean-up strategy 
If you are ready to clean up your email, and you are intimidated about where and how to start, 
you can try this strategy…  
 
Focus on the day-forward first messages first.  Pick a start date for managing new email.  Move 
all older email to a folder titled with a date range (example:  pre-2020).   
 
Consistently manage new messages as they are sent and received, and adopt new 
recordkeeping habits.   
 
Don’t worry about the old stuff at first.  Wait 6-12 months to clean up the old email.  New 
habits will make clean up easier when you are ready. 
 



 
Notes: 
Tip:  Know the Maximum 
What is the maximum retention period of the records you are responsible for keeping? Refer to 
the agency specific schedule for your office, as well as the general schedules, to determine the 
retention periods for the records that you maintain. The schedules are available online at 
https://inside.michigan.gov/recordsmanagement.  
 
If you don’t have time to review each individual email message in your account, you can retain 
all the email in your account for the maximum timeframe. Once you know the max, you can use 
rules or search techniques to find records older than the max, and delete them annually.   
 
The next slide illustrates how this works for some employees. Hopefully, these examples will 
help you determine your max. 
 

https://inside.michigan.gov/recordsmanagement


 
Notes: 
The following are case studies that illustrate how some employees manage their email.  They 
may help you figure out what the maximum retention period is for the email you have.  
Remember, retention schedules are available online, so you can look up the retention periods 
for records maintained by your office. 
 
Administrative Assistant 
I am an Administrative Assistant for a 17 level State Administrative Manager. I am responsible 
for making large purchases for the office, time keeping, schedule meetings, reviewing letters, 
memos, and other communications for distribution to our internal partners and the public. I 
have access to a document management system and all “official” communications, and the 
subject and project-based records are stored there. Timekeeping and procurement records are 
managed in SIGMA. Any communications with staff regarding purchases or timekeeping can be 
disposed of according the General Schedule for Administrative Records, which says that 
Transitory Records – are retained until activity is completed. The rest of my email 
communications fall under the same general schedule which says that General Correspondence 
needs to be retained until the date sent or received plus 2 years. Our office does have an 
agency specific retention schedule; however, I am not directly involved in any of the business 
processes. I can be comfortable setting my auto delete feature in Outlook to creation plus 2 
years and be in compliance with the retention policies.  
 
  



Financial Analyst - DTMB Finance 
I am a Financial Analyst in the finance unit of DTMB. I am responsible for assisting with the 
analysis and development of budget projections for the DTMB divisions I am assigned to. I assist 
them in monitoring expenses and making budget adjustments as necessary. I provide assistance 
with the interpretation and management of budgets including current and long-term economic 
and business trends. I assist them in assessing how trends may have a financial impact on 
programs and service rates. Most of the records I create or receive are related to my agency 
specific schedule item numbers 309015 for Financial Workpapers and 309016 for Financial 
Reports. Both retention periods are until the end of fiscal year plus 7 years, and are organized 
and stored on the offices network share drive. Any email I receive related to my work is 
incorporated into the workpapers. The rest of my email communications fall under the General 
Schedule for Administrative Records, which says that General Correspondence needs to be 
retained until the date sent or received plus 2 years. If I choose to document my activities in the 
network shared drive, I can set my auto delete in Outlook 2 years. If I choose to use my email 
account to supplement my workpapers on the network shared drive, I should set my auto 
delete in Outlook to 8 years (to cover the full retention period). Either choice will be compliant 
with our retention policy.  
 
IT Analyst - DTMB, Design and Delivery 
I am a Technology Analyst for DTMB – Design and Delivery. I am responsible for monitoring and 
maintaining the email messaging system. I receive requests for service to query the application 
for data and documents that are needed for litigation and Freedom of Information Requests, 
and I work with customers to define the scope of their query. The customer is responsible for 
keeping our communications, and the objects that are retrieved from the query. The Remedy 
application tracks the ticket activity. I am also responsible for creating, modifying and deleting 
email accounts as directed by the agency Authorized Requestor. This process is also 
documented through Remedy. The rest of my email communications fall under the General 
Schedules Non-records and Administrative Records. If requests are properly documented in 
Remedy, I can set my auto delete functions in Outlook to be 2 years.  If my email is needed as a 
supplement for a Remedy ticket, then I should auto delete email after 7 years, to comply with 
the Design and Delivery retention item #38681 for Remedy Support System Data.  
 
Human Resources Analyst 
I am a Human Resources Analyst with DHHS. I review recommendations for employee 
promotions, transfers, suspensions and separations. I conduct interviews with potential new 
employees, and I review and approve selection criteria for filling vacancies.  I also prepare 
statistical reports regarding hiring practices and other selection data. Hiring processes are 
documented in NeoGov, and employee files and labor relations files are managed in our 
Electronic Document Management System (EDM). Any employee specific email not otherwise 
documented in a formal process is filed directly in the EDM. All other communications are 
administrative or transitory in nature. I am confident that if I file records into our EDM, and I set 
my auto delete in Outlook for 2 years, and I will be in compliance with our retention policies.  
 
  



Maintenance Worker - MDOT 
I am a Maintenance Worker for MDOT assigned to perform general maintenance and repair 
work on the Blue Water Bridge. I don’t have an assigned computer workstation. A few times a 
week I will access a shared workstation to check my email, update timekeeping, and submit 
reimbursement requests. The email I send and receive is either informational and falls under 
the General Schedule for Non-records, or it is transitory and falls under the General Schedule 
for Administrative Records. I delete most of it after I read it, but if I set my auto delete feature 
in Outlook to 2 years, I would be compliant with my retention policy for any communications I 
may receive.  
 
Executive Director 
I’m a Director of a large state agency. I am responsible for the overall direction of the 
department. I am member of the Governors Cabinet and multiple internal cross-departmental 
committees. I am also a voting member of a public committee subject to the Open Meetings 
Act. Our office does not have an agency specific retention schedule and exclusively uses the 
State of Michigan’s general schedules. I may choose to delete received email that is considered 
to be “non-record” material according to the General Schedule when it is no longer needed for 
my reference purposes. Communications related to the subjects, projects or activities 
concerning my department are subject to the General Schedule for Administrative records, 
which covers the Administrative Subject Files of Executive Offices. Given the importance of my 
position in the organization, these communications are required to be transferred to the 
Archives of Michigan once they are no longer considered to be of ongoing interest. If I have a 
centralized filing system for the office to retain subject file materials including email, I can treat 
these communications as convenience copies. If I have no central repository for the executive 
office, then I must retain and manage them in my email and my email will be transferred to the 
Archives of Michigan when I change positions or depart from state government.  
 



 
Notes: 
Tip:  Delete the easy stuff 
When cleaning up your email account, it can help to get rid of the easy stuff, like mass mailings, 
newsletters, advertisements and messages from friends and family.  These types of messages 
usually are not needed for work purposes.  The General Schedule for Non-record Materials 
authorizes the destruction of these types of email.   It is available online at 
https://inside.michigan.gov/recordsmanagement. 
 
If you sort your messages by sender or recipient name it should be easy to find these.  The 
Outlook search toolbar can also help you find these messages.  For example, you could search 
for "Gongwer" to find all of those newsletters and delete them. 
 

https://inside.michigan.gov/recordsmanagement


 
Notes: 
Tip:  Quick Clean-up 
If you use Microsoft Outlook, some folders should be emptied quickly (at least monthly, if not 
sooner).  They include Junk, Clutter and Deleted Items.   
 
These folders should not be used for storing work records.  After all, you would not store 
important paper records in the trash.   
 
However, you may need to quickly review the messages in these folders prior to destruction for 
verification purposes, because you might not agree with Outlook that a particular message is 
junk or clutter. 
 



 
Notes: 
Tip:  Organize Email 
Software, like Microsoft Outlook, does not require that messages be organized - it is the 
responsibility of the user.   
 
Avoid storing all of your email in the Inbox or Sent Mail folders.   
 
Messages should be organized into topical or project folders, because organized folders make it 
is easier to find messages.  Also, users can delete the entire folder when the retention period is 
met, and they can avoid weeding individual messages when the messages are organized into 
folders. 
 
 
 



 
Notes: 
Tip:  Re-organize Email 
If all of your messages are currently kept in your Inbox or Sent Mail folders, you may want to try 
to find all messages about a particular issue or project so you can organize them.  You can do 
this by clicking on the column header in your mailbox and sorting by sender/recipient or by 
message subject.   
 
Be aware that names may be formatted differently over time.   
 
Once the messages are sorted, you should review them and either re-file them (if they have 
continuing value) or delete them (if their retention period has been met).   
 



 
Notes: 
Tip:  Email in the Cloud 
Be aware that Outlook will only display up to 250 messages per inquiry. 
 
Outlook stores older messages in the cloud. Don't forget to view the older messages.  If the 
folder contains older messages, it will say “There are more items in this folder on the server, 
click here to view more on Microsoft Exchange” at the bottom of the message list.   
 
All messages in the search result list should be reviewed for re-filing (if they have continuing 
value) or deletion (if their retention period has been met).   
 
Be aware of litigation holds, FOIA requests, or other activities that affect the retention of 
records. 
 



 
Notes: 
Tip:  Outlook Search Toolbar 
Microsoft Outlook has a search toolbar that supports single criteria searches, such as keywords, 
senders, subject lines, dates, etc.   
 
Phrases can be searched by putting the words inside quotation marks, like "retention 
schedule". Boolean operators like "and" "or" can be used too. 
 
The search tool can also look for messages sent and received before a particular date. For 
example, if you want to find all messages that were sent or received prior to 10/1/2008, you 
should type “sent:<10/1/2008 received:<10/1/2008”. This search can be very useful for 
cleaning-up messages that have met their retention period. 
 
Note:  some email systems are configured to automatically delete messages after a specified 
period of time. These configurations affect more than the Inbox. They delete messages that are 
stored in folders, archives and other spaces too.   
 



 
Notes: 
Tip:  Outlook Search Tools 
Outlook provides search tools that support advanced searching options, such as searching by 
multiple criteria.  For example, these tools support searching for a person and a word in the 
subject line in a single search.   
 
Click on the search toolbar to open the Search Tools ribbon.  For even more functionality, click 
on the +More button to select another criteria to add, or go to the Search Tools button and 
select Advanced Find to open the Advanced Find screen. 
 
Outlook can search a specific mailbox, such as the Inbox, or it can search all mailboxes.  
Searching "All Mailboxes" is recommended when the messages could be located in multiple 
places. 
 



 
Notes: 
Tip:  Mailbox Rules 
If you use Microsoft Outlook, it has a Rules tool that may be of use to you. The tool allows users 
to create rules that will identify email that meets specified criteria.  Outlook can automatically 
perform the desired task on those messages. For example, Outlook can delete Gongwer 
messages after a specified number of days, such as 30 days. 
 
Rules can include the sender's name, keywords, date ranges and more. 
 
Microsoft created instructions that explain how the Rules tool works.  Read the instructions, if 
you want to learn more about how to use this tool to manage email messages.  They are online 
at http://support.office.com/en-US/article/Manage-email-messages-by-using-rules-c24f5dea-
9465-4df4-ad17-a50704d66c59. 
 

http://support.office.com/en-US/article/Manage-email-messages-by-using-rules-c24f5dea-9465-4df4-ad17-a50704d66c59
http://support.office.com/en-US/article/Manage-email-messages-by-using-rules-c24f5dea-9465-4df4-ad17-a50704d66c59


 
Notes: 
Tip:  Email Archive 
Many email systems offer an email archive tool. Employees should not use these tools.   
Current email accounts that are using cloud storage provide a lot of storage space, so the 
archive is not needed.   
 
If the archive is stored on a computer hard drive, it is not backed up. If the hard drive crashes, 
the email archive will be lost.  Also, the email archive will not be accessible when the user is not 
physically using the computer. This means that a person cannot access an archive located on a 
hard drive when they are logged into a different computer. It can also cause problems when 
trying to respond to FOIA and litigation requests, because FOIA and Litigation Coordinators will 
need to take the machine to access the email archive.   
 
It is a good idea to clean-up old email archives, especially if you have forgotten what is stored in 
them. 
 



 
Notes: 
Tip:  Printing 
Some offices still maintain paper filing systems. If you print an email, delete the electronic 
email.  Avoid duplicate record storage, and only keep one. 
 



 
Notes: 
Tip:  Saving Messages Locally 
Email can be stored in any electronic storage space where other electronic records are kept. 
These include network drives, computer hard drives, cloud, etc.   
 
Keep in mind that some storage spaces are safer than others. For example, computer hard 
drives are generally not backed up. External storage devices can be stolen or lost, which is why 
they should be encrypted if they contain confidential information.   
 
Also, some storage spaces help co-workers share records, like network shared drives. This helps 
reduce the storage of duplicate records.   
 
There are multiple file formats that can be used to save email messages. The MSG and PDF 
formats are recommended. The next slide will explain how to save messages using these two 
formats.   
 



 
Notes: 
Tip:  Converting Email 
You can drag and drop messages into Windows Explorer. This works with individual or multiple 
messages.  
 
Or, you can convert messages to the MSG Format: Go to the File menu and select Save As, then 
select Outlook Message Format (.msg). 
 
Or, you can convert to PDF Format: Go to the File menu and select Print, then select Adobe PDF 
as the Printer (.pdf). 
 
Don’t forget to delete the original message after a copy is saved elsewhere for recordkeeping. 
 



 
Notes: 
Tip:  Are you done yet? 
Another tip for maintaining your email account is to ensure that communications related to 
completed issues, tasks or activities are moved to the designated filing system; while 
communications related to incomplete issues, tasks or activities should remain in your email 
account.  The email box should be a reminder that you need to follow-up, or that you are 
waiting on someone else.  It may help to use follow up flags that will remind you to complete a 
conversation. 
 



 
Notes: 
Tip:  Keep the last message 
Often the last message in a conversation is the only one that needs to be retained. If last 
message does not contain all previous communications and attachments, some or all of the 
older messages may need to be kept too. 
 



 
Notes: 
Tip:  Conversations Tool 
If you use Microsoft Outlook, you might want to try using the Conversations tool to identify and 
delete older messages in a chain. The Conversations tool will group all messages in a 
conversation chain together and sort them chronologically. To turn on this tool, click on the 
View tab to open the View ribbon. Click the Show as Conversations checkbox. 
 



 
Notes: 
Tip:  Keep it clean 
Review messages in your email account on a regular basis, such as daily, weekly, monthly, or as 
projects end. Re-file or delete messages, as appropriate. Try to build new habits so the mailbox 
does not grow out of control. Know the retention periods for your email. Delete all email older 
than the maximum timeframe. Clean up your email account at least once a year.   
 



 
Notes: 
Tip:  Temporarily Suspend Destruction 
Check with your supervisor about temporarily suspending deletion of email, if you suspect the 
records need to be kept for legal activities like: 

• FOIA 

• Litigation 

• Audit 

• Investigation 
 



 
Notes: 
Tip:  Empty the Trash 
Do not forget to empty the deleted items folder frequently. Do not use this folder to store work 
records. After all, you probably do not store important paper records in the trash… 
 
Be aware that messages are not really gone until the trash is emptied and the email system 
backup is cleared. Remember that older Outlook messages are stored in the cloud (slide #12 
provided instructions for accessing those messages). Only 250 messages are loaded each time, 
so you may need to empty the trash multiple times. 
 



 
Notes: 
Need Assistance? 
Hopefully these tips will help you keep and maintain a clean email account.  Please visit the 
Records Management Services’ website for more information.  Thank you. 
 
Find Records Management online at https://inside.michigan.gov/recordsmanagement.  
 
 

https://inside.michigan.gov/recordsmanagement
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	Many email systems offer an email archive tool. Employees should not use these tools.   
	Current email accounts that are using cloud storage provide a lot of storage space, so the archive is not needed.   
	 
	If the archive is stored on a computer hard drive, it is not backed up. If the hard drive crashes, the email archive will be lost.  Also, the email archive will not be accessible when the user is not physically using the computer. This means that a person cannot access an archive located on a hard drive when they are logged into a different computer. It can also cause problems when trying to respond to FOIA and litigation requests, because FOIA and Litigation Coordinators will need to take the machine to ac
	 
	It is a good idea to clean-up old email archives, especially if you have forgotten what is stored in them. 
	 
	 
	Notes: 
	Tip:  Printing 
	Some offices still maintain paper filing systems. If you print an email, delete the electronic email.  Avoid duplicate record storage, and only keep one. 
	 
	 
	Notes: 
	Tip:  Saving Messages Locally 
	Email can be stored in any electronic storage space where other electronic records are kept. These include network drives, computer hard drives, cloud, etc.   
	 
	Keep in mind that some storage spaces are safer than others. For example, computer hard drives are generally not backed up. External storage devices can be stolen or lost, which is why they should be encrypted if they contain confidential information.   
	 
	Also, some storage spaces help co-workers share records, like network shared drives. This helps reduce the storage of duplicate records.   
	 
	There are multiple file formats that can be used to save email messages. The MSG and PDF formats are recommended. The next slide will explain how to save messages using these two formats.   
	 
	 
	Notes: 
	Tip:  Converting Email 
	You can drag and drop messages into Windows Explorer. This works with individual or multiple messages.  
	 
	Or, you can convert messages to the MSG Format: Go to the File menu and select Save As, then select Outlook Message Format (.msg). 
	 
	Or, you can convert to PDF Format: Go to the File menu and select Print, then select Adobe PDF as the Printer (.pdf). 
	 
	Don’t forget to delete the original message after a copy is saved elsewhere for recordkeeping. 
	 
	 
	Notes: 
	Tip:  Are you done yet? 
	Another tip for maintaining your email account is to ensure that communications related to completed issues, tasks or activities are moved to the designated filing system; while communications related to incomplete issues, tasks or activities should remain in your email account.  The email box should be a reminder that you need to follow-up, or that you are waiting on someone else.  It may help to use follow up flags that will remind you to complete a conversation. 
	 
	 
	Notes: 
	Tip:  Keep the last message 
	Often the last message in a conversation is the only one that needs to be retained. If last message does not contain all previous communications and attachments, some or all of the older messages may need to be kept too. 
	 
	 
	Notes: 
	Tip:  Conversations Tool 
	If you use Microsoft Outlook, you might want to try using the Conversations tool to identify and delete older messages in a chain. The Conversations tool will group all messages in a conversation chain together and sort them chronologically. To turn on this tool, click on the View tab to open the View ribbon. Click the Show as Conversations checkbox. 
	 
	 
	Notes: 
	Tip:  Keep it clean 
	Review messages in your email account on a regular basis, such as daily, weekly, monthly, or as projects end. Re-file or delete messages, as appropriate. Try to build new habits so the mailbox does not grow out of control. Know the retention periods for your email. Delete all email older than the maximum timeframe. Clean up your email account at least once a year.   
	 
	 
	Notes: 
	Tip:  Temporarily Suspend Destruction 
	Check with your supervisor about temporarily suspending deletion of email, if you suspect the records need to be kept for legal activities like: 
	• FOIA 
	• FOIA 
	• FOIA 

	• Litigation 
	• Litigation 

	• Audit 
	• Audit 

	• Investigation 
	• Investigation 


	 
	 
	Notes: 
	Tip:  Empty the Trash 
	Do not forget to empty the deleted items folder frequently. Do not use this folder to store work records. After all, you probably do not store important paper records in the trash… 
	 
	Be aware that messages are not really gone until the trash is emptied and the email system backup is cleared. Remember that older Outlook messages are stored in the cloud (slide #12 provided instructions for accessing those messages). Only 250 messages are loaded each time, so you may need to empty the trash multiple times. 
	 
	 
	Notes: 
	Need Assistance? 
	Hopefully these tips will help you keep and maintain a clean email account.  Please visit the Records Management Services’ website for more information.  Thank you. 
	 
	Find Records Management online at 
	Find Records Management online at 
	https://inside.michigan.gov/recordsmanagement
	https://inside.michigan.gov/recordsmanagement

	.  

	 
	 





